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Anveo EDI Connect

Exchange your business data from Microsoft Dynamics via your preferred interface

Anveo EDI Connect supports all message types.
Typically: Purchase Orders, Order Response, Invoices,
Credit Memos, Dispatch Advices, Inventory, Sales Reports, ...

>

EDI X12 XML Csv TXT

All EDI-Formats: EDIFACT, X12, XML, Text/CSV ...
(containing VDA, IDOC, OpenTrans, EANCOM, and many more)

Company EDI Partner
using Microsoft Dynamics Customer, Vendor, Warehouse, ...

Available for Microsoft Dynamics 365 BC (Business Central)

and Microsoft Dynamics NAV 2009 R2 - 2018




The Anveo Role Center

Keep an overview of your exchanged data

All incoming and outgoing transactions , ; Busines

are clearly arranged in the Anveo EDI
Connect Role Center. CRONUS AG EDI Settings Warehouse Sales Purchasing Posted D

EDI Business Transactions  EDI Processing Queue  EDI Documents  EDI Transmissions Mo

Navigate quickly and easily to the

business transactions of interest to you. ACTIONS

> EDI Reset Demo Data > New EDI Business...ansaction Type > Job Queues
In the event of an error, you are > New EDI Mapping > New EDI Action Group E| EDI Batch Processing
informed directly. Move immediately to > New EDI Project > New EDI Communication Channel

the corresponding information and get

help to find a quick solution. Insights

EDI Activities~
Of course, you can customize the Role EDIBUSINESSTRANSACTIONS

Center to your individual needs. PROCESSED EXPECTED INTERACTION ERRORS
(TODAY) REQUIRED

1 0 0

> >

PROCESSING WAITING FOR WAITING FOR..
FAILURES USER (OVERDUE)

1 N N




The Anveo EDI Connect Components

All requirements for an interface platform combined in a single product

The Anveo EDI Connect solution is composed of several components that make it easier for you

to connect business partners.

EDI SETUP ASSISTANT

Definition of data
transformation
takes place in
Microsoft Dynamics.

Automatically detects
the message structure
of EDIFACT and XML.

CONVERTER DATA TRANSFER

Transform your data
directly in Microsoft
Dynamics — without
the need for external
software.

Transfer your data to
EDI partners and keep
control with the EDI
Role Center.

Electronic data interchange between
business partners.

Send and receive business documents.

Keep control over your EDI data in
Dynamics.

Dynamics converter to process any data
formats.

Inter-company posting feature for any
documents.

Configure your own EDI workflow.

Services




Setting Up Data Formats

Quickly and easily define data conversion with Anveo EDI Connect

Anveo EDI Connect is an add-on for MS Dynamics
with fully integrated setup and operations. Data
conversions are easily configured with just a few
clicks.

No external converter or additional service
provider is required to transform XML, EDIFACT,
or X12.

All data transformations are executed on
Microsoft’s Dynamics service tier (or the Classic
Client).

Available for Microsoft Dynamics 365 BC (Business
Central) and Microsoft Dynamics NAV 2009 R2
(technical, executable also with previous database
ersions) up to version NAV 2018.

“Fortunately, with Anveo we have found a
solution that meets all our requirements.”

Richard Liinamo, Furniturebox

EDIMAPPING (ANVEO EDI CONNECT) ( / Y + o}

DEMO - NAV - CREATE_ORDER

Process Versioning Debug Create Show Attached Actions Navigate Less op|
General
Project Code l v Code CREATE_ORDER
Format Code NAV >4
Lines Manage
MAPPING 1 TYPE MAPPING 2
EDI Document 1 :,gzj Table EDI Document
Sales Header 1 Table Sales Header
“EDI Document 1"."Document Date" -p "Sales Header 1"."Document Date"
“EDI Document 1"."Sell-to Customer No." -» "Sales Header 1"."Sell-to Customer No."
“EDI Document 1"."Promised Delivery Date" -p "Sales Header 1"."Promised Delivery Date"
"EDI Document 1"."Requested Delivery Da... - "Sales Header 1"."Requested Delivery Dat¢
“EDI Document 1"."Ship-to Code" - “Sales Header 1"."Ship-to Code"

Quick Edit Properties Manage

Services




The Anveo Assistant For Importing EDI Formats

Save your valuable time by importing XML and EDIFACT sample files

Unique to Anveo

The Anveo EDI Connect Setup Assistant
analyzes the EDIFACT, X12 and XML data
structure of your example files, and creates a
basic mapping structure automatically in
Microsoft Dynamics.

All EDIFACT formats/standards are supported
The message structure is automatically
detected for UN/EDIFACT formats such as
D96A. All other formats can be also read by its
generic detection.

EDI setup in just a few minutes

The Anveo EDI Connect Assistant significantly
reduces your setup time. Define your EDI data
structure with just a few clicks.




Reliability For The Future Due To Flexibility

Experience a flexible tool for all EDI requirements

Custom tables and fields

The Anveo EDI Connect setup refers to any fields
and tables including flexible data filters from
Microsoft Dynamics 365 Business Central and
Microsoft Dynamics NAV, without additional
development. Included are own buffer tables as
visualization (import) and data precalculation
(export), unless own structures are to be used.

Mappings for the complete data flow

The Anveo EDI Connect mappings are not only
used for the assignment of incoming and
outgoing data, they also offer data checks,
multi-level workflow processes or follow-up
actions such as posting.

Partner Management

In addition to the purely technical aspects,
Anveo EDI Connect also clearly organizes
information required for administration,
such as GLNs, data recipients or contact
persons. This avoids customization of the
master data tables.

Zero-Coding-Platform

The connection of an EDI partner normally
takes place without any development or
customization of Microsoft Dynamics table
structures. This minimally invasive structure
accelerates setup times and facilitates
updates.




Communication Channels

EDI files can be exchanged via different communication channels

There are many ways to send and receive EDI
messages. Some are directly supported by Anveo
EDI Connect. However, some may require a
provider or external software to increase the
control of data flow.

Commonly Used Communication Channels

FTP - File Transfer Protocol

FTPS - FTP over TLS

SSH - Secure Shell

SFTP - SSH File Transfer Protocol

Anveo EDI Connect supports the following
SCP - Secure Copy

communication directly:

X.400 - Message Handling System
AS/2 - Applicability Statement 2

e POP3 - Post Office Protocol 3 AS/3 - Applicability Statement 3

* File based (including UNC network shares)

« SMTP - Simple Mail Transfer Protocol OFTP - Odette File Transfer Protocol
B e e OFTP 2- Odette File Transfer Protocol 2
e ETPS - ETP over TLS POP3 - Post Office Protocol 3
SMTP - Simple Mail Transfer Protocol
IMAP - Internet Message Access Protocol




The various types and formats are very diverse.

There are numerous formats for the exchange of data
between business partners. Anveo EDI Connect supports
almost all data formats, making Anveo an universal tool
for any EDI requirements.

On the following pages, we will present the most
common EDI formats.




UN/EDIFACT

United Nations Electronic Data Interchange For Administration, Commerce and Transport

UNB+UNOC:3+1234567890123:14+0987654321098:14+120501:1324+1

UNH+777+0ORDERS :D:96A:UN: EANGOS'
BGM+220+0RD111111+9"
DTM+137:120501:101"

Especially in Europe, EDIFACT has gained wide
acceptance and is supported by many systems.

The standard is constantly evolving. Each version
gets a version number, such as D96A, DO1B,
D10A.

Anveo EDI Connect offers a very wide-ranging
support for EDIFACT and handles all message
types and dialects.

Extract of an
EDIFACT example file

Commonly used data formats:

LU

Orders (ORDERS)

Order Confirmation (ORDRSP)
Shipment (DESADV)

Invoice (INVOIC)

Advice Of Settlement (REMADV)

Load Data(IFTMIN)
Sales Data (SLSRPT)
Inventory (INVRPT)
and a lot more ...

Data Formats

10



XML-Files

Extensible Markup Language

XML example file

XML-based file formats

v IDOC
v' cXML
v' OpenTrans
v' and more ...

<?xml>

<Root

xmlns="http://anveogroup.com/2014/examples/communication” .%
>

<Item No="IX3241"> g
<Description> -
Item description with <b>Formated</b> Text s
</Description> o
</Item>

</Root>

XML files are supported by many systems. The format is easily
readable by both the computer and, with a little practice, humans.
The data is structured in elements.

Anveo EDI Connect supports XML files with various features, such
as namespaces, prefixes, and many more.




Plain-Text / CSV

Simple text formats

Quite often, text separated formats are
used to organize simple data structures
such as item master data. Although its
format is quite simple to read and
understand, it may be difficult to represent
complex data structures.

Anveo EDI Connect supports formats with
fixed field lengths, with dynamic and mixed
types. It is possible to define optional
elements and record-based text formats
such as VDA.

CSV example file

# Record Type = CUST;Name;No.
CUST;Smith, John;1000

# Record Type = ORDER;No.;Item No.;Qty
ORDER;10023;IX3243;5
ORDER;10023;IX3241;1
ORDER;10023;IX3248;2

Data Formats




License

1.

The basic license provides all core functions and is required
once for each installation.
Add the Enterprise Option on demand.

2.

In addition, each license package contains a different
number of mappings. Alternatively, these can be licensed
individually.

A mapping is the definition of an EDI message type for
one communication partner.




License

The Anveo EDI Connect licensing consists of a basic license plus the required mappings

One Anveo license covers one live and one development system.

Setup in Assistant for Role center Debugger Data transfer
Dynamics Client data structure and converter 2 file, email, FTP

+ ENTERPRISE OPTION

2. MAPPINGS Benefit from extended range of functions:

Versioning Mappings

Automatic go-live of mappings on
specific dates

X12/

Text/CSV EDIFACT

Unlimited number of Dynamics
companies for live operation and
development

The Anveo license is bound to a Microsoft Dynamics license. Without the Enterprise Option, the basic license and mappings are required
for each Microsoft Dynamics company. The Dynamics company name for the development system must clearly indicate that it is one.




The Flexible Anveo EDI Connect License

Individually configure your Anveo EDI Connect license

MAPPINGS

2 EDIFACT / X12 €500
10 XML €500
10 Text / CSV €500

Enterprise Option
+ € 5.500

Purchase license plus 18% Anveo service plan per year for the right to update to the latest Anveo version and to extend the Anveo license.
Mandatory for the first year. The installation of the update is not included in the service plan. The cancellation period for the Anveo Service
Plan is one month before expiration.




Or Use the Anveo EDI Connect License Packages

The right package for every EDI integration as a cost-effective alternative to flexible licensing

BUSINESS

PREMIUM

Base license incl. mappings
3 EDIFACT/X12
10 XML
10 Text/CSV

€ 3.500 or

€ 155 per month

Base license incl. mappings
10 EDIFACT/X12
20 XML
20 Text/CSV

€ 5.500 or

€ 240 per month

UNLIMITED

Base license incl. mappings
Unlimited EDIFACT/X12
Unlimited XML
Unlimited Text/CSV

On demand

Enterprise Option
+ € 3.500 or
+ € 155 per month

Enterprise Option
+ € 5.500 or
+ € 240 per month

Enterprise Option
on demand

Purchase license plus 18% Anveo service plan per year for the right to update to the latest Anveo version and to extend the Anveo license.
Mandatory for the first year. The installation of the update is not included in the service plan. The cancellation period for the Anveo Service Plan
is one month before expiration. Subscription: Duration is until 30.06. or 31.12. of a year (at least one full month), thereafter every six months.

One month corresponds to 30 days for monthly shares. Reduction of the license or termination at the end of the term possible. Invoice and
payment on the first day of the respective performance period.




The Flexible Rent Model of Anveo EDI Connect

Do you need the Anveo EDI Connect license as a rental model? Use Anveo Subscription.

Low investment
‘ : 6 .> Service Plan for latest

Anveo versions is
per 10 XML mappings Extend your license at any
or 10 text/CSV mappings time as requirements change
or 2 EDIFACT/X12 mappings

Term is semi-annual and automatically extended. First period is pro rata until June 30 or December 31 of a year, at least one full month.
Reduction of the license or termination at the end of the term possible. Invoice and payment on the first day of the respective
performance period.



The Anveo Service Plan enables you to access the latest features at any time.

The Anveo Service Plan secures your Anveo investment, and
you get access to new functions and optimizations.

The Benefits

= Right to receive all Anveo EDI Connect versions during the
validity period of the Service Plan. Installation as a service
must be performed by the Anveo Partner or ordered
separately at a charge

= Anveo license upgrade right

= Automatically renews for one year at a time unless cancelled

= Cancellation period 1 month before expiration

= Mandatory in the first year, optional as of the 2nd year

18% of the license value per year
Proportional when extending a license

The Anveo Service Plan is already included in the monthly
subscription fee.

License




Anveo EDI| Connect — Quality Review Plan

Respond to constantly changing markets and companies by optimizing processes and infrastructure

The Anveo Quality Review provides regular reviews to identify meaningful changés,and necessary maintenance
tasks. This ensures that the desired increase in efficiency is sustained.

Take advantage of our experience from countless projects and secure your investment.

YOUR BENEFITS
v Increase efficiency through better data
quality and speed

v The solution is more stable,
your team is more satisfied

v' Secure your investment €120

License

monthly
per Dynamics
company using
Anveo EDI Connect

Available for a minimum of 12 months and will autematically renew if not canceled at least one month prior to expiration. Many services are ineluded in the price of the
regular checks, such as reviewing the automations, the usability, @and the processing jobs. However, some checks may incur follow-up costs, especially for validation of
existing processes, which cannot be included in the price due to their varying scope and are therefore chargeable. A quote will be provided for this prior to any services
being provided. The exact scope of services can be found on our docs page.



https://docs.anveogroup.com/en/kb/services-of-the-anveo-edi-connect-quality-review/

Services

Anveo offers additional services to support the
implementation of Anveo EDI Connect. Anveo is
optimized for independent development by a Microsoft
Partner for Dynamics.

v’ Creation of a requirements analysis

v’ Installation of Anveo EDI Connect

v' Configuration of mappings in Dynamics
v’ Developer's manual with examples



Anveo Projects

Individual, practical training for your project managers and developers

The various tasks can be allocated
individually for each Anveo project.

Microsoft Partner
for Dynamics Typical Tasks
as an Anveo Partner
Requirements Analysis

Installation

Customer

with its own

project management,
if available.

Anveo Configuration Of Mappings

support and

: : Communication With
configuration

All Project Partners

Services

Test Phase / Go Live

Integration

On request, we can take over parts of the implementation or the User Training / Documentation
entire solution development in the case of limited resources.




Anveo Training

Individual, hands-on training for your project managers and developers

Typical content
Overview about the product
Configuration of XML mappings
Configuration of X12 mappings
Configuration of CSV mappings
Configuration of EDIFACT mappings
Customizations

Setup of communication

Your benefit: You can independently
implement Anveo projects.

Individual trainings
You set the focus and decide on the
content.

Practice oriented

Take the first project steps in a
training course: Instead of
theoretical considerations, your
concrete customer requirements
are already implemented.

Multiple, short online sessions
allow you to apply what you have
learned between the trainings and
secure your investment in the long
term.

TRAINING

Practical training of your team
to develop your own solutions.

3 x 2 hours online or
1 day in Hamburg at Anveo
plus 2 hours support
for further questions

Services




Successful Implementation of EDI Projects with Anveo

In our many years of experience with EDI projects, we have identified three typical types of cooperation with
Anveo. Depending on the scenario, we recommend the following services:

Own Implementation
Of Your EDI Projects

Your company already has
extensive EDI knowledge and all
you need is an introduction to the
Anveo EDI Connect solution. If
you have any questions, please
do not hesitate to contact us.

Implementation By
Your Dynamics Partner

Your Microsoft Dynamics partner
implements your EDI project. We
help with the first setup in the
form of a training.

Of course we are available for
guestions at any time.

(%]
Q
=2
>
—
Q
n

- Ny
« & 5
b W R, ool TR WY [ 4 s - TR s S X’ I w

We would like to point out that due to the individuality of EDI projects, with our recommended services no complete project
implementation can take place. They represent a recommended, first step in the EDI project. Further efforts are necessary.



Anveo Managed File Transfer (MFT)

With Managed File Transfer, Anveo offers its own solution for automatic data exchange when using BC Online.

With the web-based Anveo Managed File
Transfer portal, you get a simple and fast
overview of all exchanged data.

New data connections can be created and
managed quickly and easily by you here.

It also provides an overview of the live and
test clients to be managed.

The MFT service supports the following
protocols:

FTP/FTPS (client side)

SFTP (client side)

AS/2 (server and client)

X400 (via external service partners)

Other protocols can be requested.

SimonsCompany nbox  Fetched Outbox Sent Settings ™~

FETCHED

0

The MFT Dashboard provides an overview
of your data transfers.

The MFT Inbox gives detailed information about

incoming and outgoing messages.

Services

Simons Company  Inbox Fetched Outbox  Sent  Settings =

INBOX  Refresh

Partner Sent At Received At Status

BIGFILE-2txt H MY-TEST 26.05.2020, 15:18:13 MESZ 26.05.2020, 15:18:13 MESZ

testdat H Simans Company 19.05.2020, 13:32:16 MESZ 18.05.2020, 13:32:16 MESZ

[3  testdat H Simans Company 19.05.2020, 12:50:06 MESZ 19.05.2020, 12:50.06 MESZ




Technical structure of the Anveo Managed File Transfer

FTP
MANAGED FILE £l
MICROSOFT TRANSFER SFTP PARTNER
DYNAMICS 365
BUSINESS CENTRAL - Data exchange -
Online (Saa$) as Saa$ solution in ED
Microsoft Azure PARTNER

(%]
Q
=2
>
—
Q
n

With the Anveo MFT service you get the possibility to easily exchange data within a Microsoft Dynamics 365 Business Central Online
environment.

The service is only available for Anveo EDI Connect solutions for Business Central (Public Cloud / SaaS) and On Premises installations
from version 14 (extensions only). For more information, please visit our website at https://anvgrp.co/docsmft.



https://anvgrp.co/docsmft

First Steps with Anveo EDI Connect

We will be glad to assist you in evaluating Anveo EDI
Connect. We offer the following options:

v' Demonstration and training videos on our website

v’ Personal online presentation

v" Individual consulting - we are happy to answer your
questions




Get An Overview

DEMO AND TRAINING VIDEOS

We provide free demo and training videos on our website.

See our demo videos on how to use Anveo EDI Connect to import EDIFACT or export XML files directly
into Microsoft Dynamics.

Training videos are available on our website for the following scenarios:

v.  Import of EDIFACT Orders

v" Export of EDIFACT Invoices

v' XML import and export of orders and
order responses

27


https://www.anveogroup.com/de/edifact-xml-export-import-video-dynamics-navision/#Anveo-EDI-Connect-Trainings

Experience Anveo Live

Attend a Webinar - Register Now

We will introduce you to our Anveo EDI Connect solution
in a personal online presentation.

We will be happy to answer your questions and assist you
during the concept phase.

Register now at www.AnveoGroup.com.




The Starter Package is designed to
accompany the first steps towards

AﬂveO EDI COI’mect Sta rter PaCkage getting to know the solution. A complete

project implementation is not covered.

Features

The first steps made easy

30 Days Trial License 4 Days Of Flexible Support For Your EDI Project

With the Anveo EDI Connect Starter Package, you can start your EDI project
flexibly, tailored to your requirements. Depending on the project phase and
previous knowledge, the tasks for the Anveo team can vary and might include:

v Requirements analysis

v Implementation of mappings

v’ Training

v' Communication with project participants
v’ Project management

v’ Test phase / Go-Live

v’ Integration

Services

Benefit from our many years of experience in connecting

numerous EDI communication partners.



Anveo EDI Connect — Setup at a Fixed Price

Project implementation with maximum planning security

Benefit from our experience in hundreds of
successful projects and book your
Anveo EDI Connect setup at a fixed price.

Vs

-
All 4 packages €\1 4.900
or 3 of 4 packages € 10.900

Order

Such as Orders

f»y‘ 7

&

Invoice
Suchas INVOIC /

€4.900 /

Sﬁipping notification
Such as DESADV

///////..

€3.800

Order confirmation
Such as ORDRSP

€3.800

€3.800
e

YOUR BENEFITS

Benefit from our experience

Clearly defined scope of services

project security means investment security
Highest user acceptance thanks to Best practices
Also included: Anveo Quality Review Plan*

The package can only be booked after a feasibility check has been carried out and positively confirmed by Anveo. The offer will be based ona detailed project plan. Further
information and the conditions for implementation can be found here. A valid Anveo EDI Connect production license is required for implementation at the start of the project/-
this is not part of the fixed-price project. *If you start the project within 4 weeks after receiving our quote, you will receive the first year of Anveo Quality Review free of charge.

For more information on the Anveo Quality Review Plan, click hete.



https://docs.anveogroup.com/en/kb/anveo-mobile-app-fixed-price-projects/
https://docs.anveogroup.com/en/kb/services-of-the-anveo-edi-connect-quality-review/

STARTER PACKAGE

v’ 30 Days Trial License
v’ 4 days flexibly usable
support

A
T

€3.960 "

€ 1 20 monthly

I Mcax

starting at € 3800




The Anveo Product Family = ANVeOo

The Anveo product family provides powerful extensions
for Microsoft Dynamics.

The Anveo products are sold by more than 450 Microso
Partners worldwide. :

MOBILE APPS WEB APPS

Electronic Data Inter-
change 100% powered
Create your individual, by Dynamics.
fully offline-capable Web-based solutions Experience EDIFACT

app directly in for Microsoft Dynamics without any external
Microsoft Dynamics. 365 Business Central. converter.



AnveoGroup.com
info@AnveoGroup.com

Phone
Europe +49(0)40/211078 100
Us (813) 448-7617
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